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Congratulations on your purchase of Allegro 2005 for Macintosh! 
 
IMPORTANT: Read this document before you begin working with Allegro 2005 and print a copy of it to 
keep with your Allegro information.  
 
This file contains important information about Allegro 2005 not included in the User Manual as well as 
information about converting older files into the new version's format. Please note that Allegro 2005 files 
cannot be opened in previous versions of Allegro. 
 
This document is organized by each version's changes; those of you already familiar with earlier versions 
may wish to read only the new information. The Read Me contains the following sections: 
 

Running Allegro 2005 
New features in Allegro 2005 
Fixes in Allegro 2005 

 
You may also visit our web site, www.finalemusic.com for updated information about Allegro and 
information on new releases. 
 

Running Allegro 2005 
 
System Requirements Change 
Allegro 2005 for Mac requires OS X, 128MB RAM (256MB RAM recommended), and 200MB of free 
hard drive space. 
 
Adobe Acrobat Reader 
The Adobe Acrobat Reader is required to view the User Manual and the electronic version of the 
Installation and Tutorials Manual. 
 
User Manual 
For full documentation on how to run Allegro 2005, see the User Manual. To access the User Manual, 
choose the Help menu, then User Manual, then Table Of Contents. 
 
Registering Allegro 2005 
The first time you launch Allegro, you will be prompted to register. To register a single copy of Allegro, 
click Register Now! to open the Registration Wizard (or, from the Help Menu, choose Register Allegro). 
Then follow the instructions to register your copy of Allegro via the Internet, phone, or mail. If you choose 
not to register, you will be prompted to do so each time you launch Allegro. If you do not register within 
thirty days, printing and saving are disabled until you choose to register. 
 
Note that the User/Authorization Codes are computer specific, and will only work on the given computer 
installation. Verify that the correct serial number has been entered. If you make a change to the computer 
(such as replacing the hard drive or motherboard, or install a new operating system), then you will need to 
re-authorized the installation. If you have already installed and authorized twice, you will need to contact 
Customer Service directly by phone, FAX or standard mail with your serial number and the location ID for 
the specific installation in question, and one of our representatives can clear the previous authorization 
from your account. If the software is not "reminding" you to register when you run the program, then the 
registration/authorization has been successfully completed. 
 



Dragging while holding down a metatool key on notebook computers 
Some notebook computers are set to limit trackpad mouse movement while typing. As a result, you may 
experience sluggish performance while dragging over items while holding down a metatool key. To resolve 
this, open the Preferences pane and deactivate "Ignore accidental trackpad movements."   
 
Phone Technical Support 
The phone number for MakeMusic Customer Support is (952) 937-9703. FAX# (952) 937-9760. 
 
Converting old Allegro documents into Allegro 2005 documents 
Allegro 2005 has a different file format than earlier versions, and converts older files to the new format 
when you open them in Allegro 2005. You should be aware of the following points: 
 
Opening old documents 
Allegro 2005 will open and convert older versions' documents, giving them the default title 
"UNTITLED.MUS." We recommend saving a newly converted document with a different name than the 
original file, keeping the older unconverted file as a backup. If you do want to save the file using the same 
name, choose Save As from the File menu. Allegro displays the original file name, so you can click OK to 
rewrite over the old file. 
 
Running older versions of Allegro 
Allegro 2002, Finale Guitar, and other earlier Finale family notation products for Windows or Macintosh 
cannot open any Allegro 2005 file, except Standard MIDI Files. To share Allegro files, the Allegro 
application must have the same (or later) version number. 
 
Allegro Preferences File 
The Allegro Preferences file contains many program settings, from the configuration of your tool palette to 
the display colors you select. Allegro stores this file in your System Folder's Preferences folder, although it 
will look first in the same folder for a Preference file. 
 
Allegro 2005 does not share the preferences file with older versions of Allegro. Allegro 2005 will 
automatically load the new Allegro 2005 default settings upon launching Allegro for the first time. If you 
would like to use preferences from an earlier Allegro version of Allegro, go to User/Library/Preferences 
and delete the File "Allegro 2005 Preferences". (If you are moving preferences from OS 9, go to System 
Folder/Preferences folder, and copy the Allegro 2002 Preferences to User/Library/Preferences). Then, 
rename "Allegro 2002 Preferences", "Allegro 2005 Preferences".  
To use Allegro's default settings at any time, simply delete the Allegro 2005 Preferences file from the 
System Folder/Preferences folder. A new preferences file will be generated the next time you start Allegro. 
 
Keep in mind that just as older versions of Allegro cannot read the newer version's music files, older 
versions cannot read the newer version's preferences. Please note that older versions of Allegro will revert 
to default preference settings each time they sense that Allegro 2005 has updated the Allegro Preferences 
file. If you think you'll continue to use older versions of Allegro and Allegro 2005 on the same computer, 
we recommend placing a copy of the Allegro Preferences file in the same folder as each Allegro program. 
 
New Features in Allegro 2005 
 

• Enhanced Graphic Interface. Allegro sports a new look with improved, customizable palette and 
background graphics. Select from a variety of styles or even choose your own custom background.  

• Improved Program Options. Allegro is optimized for efficient handling of Program Options. 
Make several changes without leaving the dialog box. 

• The Mass Mover Tool has been renamed the Mass Edit Tool. Look for the new Mass Edit icon 
in the Main Tool Palette. Also, look under the Mass Edit Menu for all features that previously 
existed under the Mass Mover Menu, and more.  

• Tablature Improvements. Copy music directly into a TAB staff with the Mass Edit Tool or enter 



into a TAB staff with the Simple Entry Tool. Creating and editing tablature is now easier than 
ever!  

• Improved Chord Functionality. Choose from new chord styles, edit fretboard diagrams, and 
much more. 

• Two new TAB clefs.  
• Use a MIDI Guitar for entry into a notation or tablature staff. Allegro can even record the 

string you play for every note.  
• Improved Setup Wizard. A new category, "Fretted Instruments" has been added to the Setup 

Wizard. Choose from a variety of fretted instruments and corresponding tablature.  
• New Tablature Libraries and Templates.  
• New Smart Shapes. Look in the Smart Shape Palette for the new Guitar Bend, TAB Slide, and 

Custom Line Smart Shapes. Use these new Smart Shapes to enter bend curves, TAB slides, and 
several other Smart Line Styles specifically designed for guitar notation.  

• New Utilities under the Mass Edit Menu; Drum Groove: With this utility, easily compose 
unique rhythms and percussion parts. Band-in-a-Box Auto-Harmonizing: This utility takes a 
selected melody line with chord symbols and outputs a harmonized melody in dozens of musical 
styles. 

• Change Lowest Fret Utility: Easily specify the lowest fret for any region of a tablature staff. 
• Create Metronome Marking: Easily create metronome markings. 
• Adjust the default placement of slurs, TAB slides, glissandos, and guitar bends with the new 

Smart Shape Placement dialog box.  
• New Display Expressions for Extracted Parts command under the Options Menu.  
• Number of Systems per Page. Now, you can specify the precise number of systems for any page, 

or for all pages in a document. 
• Internal Speaker Playback has been moved to the MIDI Menu, and is now set for the program 

instead of each document.  
• SmartScore Lite. Allegro now supports improved scanning recognition. 
• WriteExpress Rhyming Dictionary. Generate a list of rhymes from a library of over 90,000 

words.  
• Improved SmartMusic Accompaniment creation. Now, configure and save Allegro files for 

customizable part playback in Smart Music Studio. Choose each accompaniment and solo staff 
independently in SmartMusic, even during playback.  

• Change Crescendo Smart Shapes to Decrescendos (or vise versa) by dragging. 
• New Component Files folder. The Allegro folder has been reorganized. Most files that 

previously appeared loose in the root folder are now located in the Component Files folder. 
• Improved Note Entry. Enter notes, articulations, and even clef, key and time signature changes 

in Simple Entry using your computer or MIDI keyboard.  
• Enhanced Expressions. The redesigned expression designer allows you to use multiple fonts for 

the same expression, align expressions with automatic placement options and add a description for 
each expression.  

• Sound Font Playback. Allegro’s included General MIDI Sound Font offers high quality 
instrument simulation. Now, using this sound font, Allegro delivers identical playback from one 
computer to the next.  

• Human Playback. Playback of Allegro documents, as well as MIDI files and SmartMusic 
Accompaniments generated with Allegro now simulate a live human performance with automatic 
interpretation of expressions, articulations, hairpins and other markings. Choose from several 
playback styles including Baroque, Jazz, and Reggae.  

• Save as Audio File. Like the sound of Allegro’s improved playback? You can now save that 
performance in Wave format to burn to a CD, or as a compressed Wave for transfer over the 
Internet.  

• Smart Hyphens and Word Extensions. Entering lyrics just got easier. No longer manually add 
word extensions or adjust hyphens. Allegro does it for you.  

• Hidden Text Style. With this new text style, text blocks can be set to display on the screen and 
not in the printout.  

• SmartMusic Accompaniment Wizard. It is now easier than ever to create SmartMusic 
Accompaniments.  



• Easily Add SmartMusic Markers. You no longer need to manually add performance markers 
with expressions. Easily add pauses, rehearsal markers, and even scan the score to add repeat 
markers automatically with the Add SmartMusic Markers dialog box. 

• Improved scanning recognition with SmartScore Lite 3.1. 
• Import SmartScore 2.0 files. Take advantage of Musitek’s latest scanning technology.  
• Select Multiple Articulations at Once. Drag and edit any number of articulations 

simultaneously.  
• Cross-layer Accidental Positioning. Allegro now automatically avoids collision of accidentals 

between layers and aligns accidentals on intervals of an octave vertically. 
• Improved Redraw. Smoother interface handling. No more residual artifacts or need for manual 

redraws. 
• Copy Between Layers. Copy notes in one layer to another, without changing the original notes.  
• New Launch Window. Get up and running quickly with Allegro’s new Launch Window. From 

here, open existing files, choose how you want to start a new one, view reference material, and 
even import scanned documents. 

• Expanded Setup Wizard. Save time by starting a new document using one of Allegro’s preset 
ensembles, or create your own custom ensemble.  

• Engraver Tuplets. Tuplet brackets now avoid collision with notes, stems, rests, and other items 
and angle appropriately according to the notation.  

• Updated Repeats. Apply repeats to a region of your score using keystrokes and contextual 
menus; playback is set up for you automatically. You can now also assign staff lists to endings and 
text repeats. 

• Record Continuous Data. You can now record pitch bend, sustain pedal, and other continuous 
data controllers in real-time using HyperScribe.  

• Improved Grace Note Spacing. Spacing of consecutive grace notes has been improved. 
• Copy Staff Lists. You can now accurately copy measure expressions, repeat text and repeat 

ending brackets assigned to staff lists from one document to another without manually creating the 
staff lists in the destination document.  

• 3rd Party Sound Font Support. Specify your favorite sound font for playback or audio output.  
• New Navigation Keystrokes. Press Command-= to Zoom in or Command--(minus) to zoom out. 

 
 

Fixes in Allegro 2005 
 
Articulation Tool 
• The duration change on the breath mark articulation is now 75% instead of 50%.  
• The ability to print articulations attached to fret numbers below zero has been restored. 
• Articulation playback effects have been updated.  
 
Clef Tool 
• The clef tool is no longer the only tool that can affect a region of music but does not allow a region to 

be selected (like the time and key signature tools). 
 
Edit Menu  
• It is now possible to copy/cut to a clip file. 
 
HyperScribe Tool 
• Using the sustain pedal as a tap source now works with non-binary keyboard sustain pedals. 
 
Mass Edit Tool 
• Note spacing now makes room for grace notes placed at the end of a measure. Beat spacing leaves 

room for them and spaces them individually. 
 
MIDI Menu 
• MIDI input is now disabled when the MicNotator dialog box is active.  



• Choosing a menu item while the MIDI Tool window open no longer causes it to close. 
• The MIDI Tool window no longer closes after an undo. 
• In the Export MIDI File Options dialog box, “Format 0” is no longer listed incorrectly as “Format O.” 
 
Options Menu  
• Undoing a “Set Default Music Font” action is now reflected appropriately in the Font Menu.  
• If “don’t show this message again” checkbox (redefine page warning, HP warning etc.) is checked, it is 

now possible to turn the show messages back on in Program Options – View.  (Trashing preferences is 
no longer required). 

 
Other 
• Shift-arrow keys to highlight to the end/beginning of the piece (etc.) now works in all tools that offer 

regional selection. 
• The name of the format “Coda Notation File” has been renamed “Finale Notation File”. 
 
Redraw 
• Slurs now automatically redraw after transposing music. 
 
Repeat Tool 
• There is now an indication of the metatools assigned to barlines in the Repeat Selection dialog box. 
• Up and Down arrow keys now move the selection in the Repeat Selection dialog box. 
 
Selection Tool 
• Text Frame Attribute changes made via the Selection Tool are now reflected in the score without a 

redraw. 
 
Setup Wizard 
• The numbers are no longer too small and the = sign too high in the Jazz font metronome marking 

added with the Setup Wizard. 
• Ordering problems have been resolved in the Choral and Concert Band lists of the Setup Wizard. 
• Solo bass is now set to the appropriate transposition.  
• The correct playback instrument is now selected after choosing Contrabass from the Setup Wizard. 

Simple Entry Tool. 
 
Smart Shape Tool 
• Smart Shape Placement no longer changes when converting older documents with independent time 

signatures. 
• Double clicking on the document (using any Smart Shape Tool aside from Slurs and Glisses) without 

dragging no longer results in the Smart Shape and handle appearing.  
 
Staff Tool 
• Bitmaps in the Stem Settings dialog box are no longer on an off-white background.  
• Staff names that use the default music font now update when a new default music font is selected. 
• Changing the Staff name no longer causes a manual redraw. 
 
Text Tool 
• “Placement”  has been renamed “Alignment” in the Text Menu to be consistent with the rest of 

Allegro. 
• Text blocks that use the default  music font now update when a new default music font is selected. 
 
Time Signature Tool 
• There are no longer rounding errors when using a composite time signature and using edus as the beat 

duration. 
 
Tuplet Tool 
• Tuplet handles now move from their screen position if the view % is changed via Scale View dialog 



while the primary handle is selected. 
 


